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Introduction

Here you have the documentation for Gtree version 4. I am amazed that every year there are still new things that can be added and improved to Gtree. In version 4, I have added integration of R (R is a language and environment for statistical computing and graphics, see http://www.r-project.org/). Currently I am working a lot on combining GAMS with R, i.e. using the strengths of these two worlds for data calculations and manipulations. GAMS is great in optimization and R is great in statistical analysis/econometrics and graphs. Running GAMS, saving GAMS data, starting an R batch doing statistical analysis and making graphs etc., saving R data and reading data back in GAMS is easy (if you want the GAMS and R code send me an email). Since I like to do all my tasks from Gtree, adding R functionality was a logical step.
Gempack and R are useful languages, but I think that working with one big unstructured file, isn’t how people should work. With Gtree you can add GTREE tags and hence create a tree (table of contents) of the file and organize the code and make it easier to find things. Please read Chapter 10 “Special Gtree tags” since the Gtree tag statements are extended to make even better trees. Also GAMS users will benefit from these extensions.
If you have big and complex code and you work on it as an (international) group, you need a versioning system like Tortoise SVN. Gtree has Tortoise functionality, making it easy to download the last model and to commit changes to the SVN server.

Working with other peoples models and making big complex data systems in GAMS, I needed a lot of additional functionality. This was implemented in new tab pages:

· “Clipboard” remembers previous clipboard actions so you can reuse them.
· “Jump list” adding additional hyperlink functionality for files, programs and web pages.
· “History” remembers your tree navigation and makes it possible to jump back.
As always, many small bugs have been solved ( (and new ones introduced (). Please let me know if you are still missing things. I already started working on version 5…
Wietse Dol

December 2010

1. tc "Gtree"

xe "Gtree"GAMS tree
What started as fun became a serious undertaking. As part of our GAMS model user interface GSE we wrote a small Delphi program we called Gtree (GAMS tree). Gtree will show in a tree, the structure of your GAMS code (as a result of all the $include, $batclude, $libinclude, $sysinclude statements). Of course just clicking on the tree you will see the contents of the files as well. We think it is useful for having a look at other people's work and to show a good model structure to others, i.e. this is what we missed in the GAMSide. After some people tried to use it, they came with many requests for extensions of the program. Implementing these wishes we became a serious competitor for the GAMSide. Recently we even made Gtree compatible with Gempack (to organize LEItap, our GTAP model) and in version 4 we have added the interfacing with R (statistics and graphics). Both Gempack and R can use the tree structure facilities of Gtree to make the code (often one big file) accessible and easier to maintain.
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The first time you start Gtree, the program wants to scan your hard disk for GAMS. Be patient, Gtree will do this only the first time and the next time it will remember where you have stored your GAMS versions. Gtree needs to know where GAMS is, because it offers you to run GAMS code and show you the GAMS documentation etc. If you do not like this scanning you can edit the Gtree INI file and change the GAMSdir by hand.  After starting Gtree you can always scan for GAMS by pressing menu item “GAMS” and then “Find GAMS versions”.
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Gtree should be easy to use and many things need no explanation. We will, however, give you some information we think is useful to become an expert in using Gtree. When you load a file into the Gtree editor the file is scanned for $include, $batclude, $libinclude, $sysinclude statements and when this command is available the file that is $included, $batincluded, $libincluded, $sysincluded  is also read and scanned for $include, $batclude, $libinclude, $sysinclude statements. As a result of this scanning you will get a tree and it becomes visible where and how files are related. Note that Gempack and R can use the GAMS include statements by making them a comment, e.g.
#$include Demo.R

!$include Demo.gmp!

will work for R and Gempack (see also the chapter 26 R). Adding tree structures with the GTREE statement will make it possible to create a well-structured document for GAMS, Gempack and R. Gtree has possibilities to run GAMS, Gempack and R and show you the log files.
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GAMS tree version 2.0, © Wietse Dol, LEL February 2006

* File : AgMemod.gms
|* autror Foppe Bouna (foppe..boumagwur.nl)
| Version : 1.0

* Date 12/16/2005 11:03:35 AM

|+ changea 15-Mar-06 20:26:25

|* Changed by: Wietse Dol (u.dol@wur.nl)
STITLE "AGMEMOD PROJECT™

|sontext

Gams Simulation Environment

To be able to run Ag-Memod in GSE the following steps vere taken:

|i. 211 declarations of Sets, Parameters and Variables were taken
out of the country models and put into stand-alone files.

|2. Reading Excel files is time consuming, hence ve decided that
when running the BaseLine ve vill read all the Excel files and
then vrite the parameters to a GDX file. Wien running & scenario
ve vill read this GDX file and not the Excel Files.

|3. For presentation purposes GSE defines nev parameters (i.e. large
parameters and variables are chuncked into understandable pieces)
These parameters are sither Inputs in GSE (can be edited) or Outp)
Most communication vith GSE and the model is done by GDX files an|
some ASCII files that are included as comments in the Ag-memod tz|

|sorrexts

|SINLINECOM ¢ )

(#Le: tnis command allows to vrite comments in curly brackets everyv

sinclude Sectings.gms





In the example above we see e.g. which files are included in the Settings.gms file and we see the contents of the AgMemod.gms file in the editor. The [62] before the file SettingForEUTotalModel.gms simply means that on line 62 of the Settings.gms file the $include SettingForEUTotalModel.gms statement includes this file. Walk through the tree and you will see that when a file is included, the editor contains two tab sheets on the right part of the window: one with the selected file and one with its parent file (i.e. the one that contains the $include for the selected file). The teal color of the SettingForEUTotalModel.gms file indicates that it is not a normal $include but a conditional include (in our case you will see the line

$ifi "%EU_TotalRun%" == "yes" $include SettingForEUTotalModel.gms
on line 62 of the Settings.gms file).
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In the status bar at the bottom of the screen we see the cursor position and file size of the current file (1 : 1 / 65: 53693 means: column 1 of line 1 and the file is 65 lines long and the total model (all files) is 53693 lines long). Then we see that Gtree knows that you are working on files that use GAMS (i.e. it shows you which GAMS version you are using). The right hand side of the status bar is used to show errors/remarks, e.g. when running GAMS.

On the upper left hand side of the Gtree window we see two tab sheets: The first one with the name "Files" will show you a tree structure of your model (generated from all $include commands). The second tab sheet called "References" will show the structure of the GAMS model (see Chapter 4. Reference file).

A very important functionality in the editor is the syntax coloring, i.e. the color will indicate the function of a word. Just to help you remember the function of a color a legend is shown in the lower left part of the window in the tab page “Colors” (e.g. reserved words are shown in blue).

Showing a tree will not leave much space for the editor. You can collapse/hide the tree by clicking on the panel with the copyright statement (i.e. click on the [image: image6.bmp]  at the top left corner of the window, just under the File menu item). By clicking it again the tree will reappear (N.B. you can use the Ctrl-M as a shortcut key).

At the top of the screen we have a menu with the options File, Actions, Options, GAMS, R, Programs, Templates, and Help. Below we will explain their contents, their purpose and which shortcut keys can be used to invoke the menu choices.

1.1 File menu item
The File menu item contains the menu choices:
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	Open
	Empty the left tree pane, ask for a file to be loaded into Gtree, load the file and scan for include statements. The result is a tree like the examples shown above.

	Add 
	This option keeps the already loaded files (tree) and adds another file to the tree.

	Open in External Editor
	Ask for a file and open it in an external editor (default notepad2).

	File scan wizard
	In a folder that contains many GAMS files, it can be difficult to see which GAMS file you need to open. This wizard will scan a folder and show in a tree the relationships between all the files in the folder, and hence all files at the root of the tree are candidates to be opened and inspected (see below).

	Open in External Editor
	Select a file that is then opened in the external editor (default notepad2.exe)

	Open and Run
	Ask for a file and open it with the associated program. This means you can open e.g. a Word document or an Excel spreadsheet.

	New file
	Create a new model

	New model with tree template
	Create a new model tree with the aid of a template: see  Chapter 29. New model with tree template 

	View in Windows Explorer
	Start the Windows Explorer in the model directory

	Save as…
	Save the current file under a new name

	Remove file from tree
	Deletes the file from the tree.

	Remove whole tree
	Clears the whole tree and removes all the files from the tree.

	Delete file and remove from tree
	Deletes the file from disk and from the tree.

	Delete Todo list
	Remove the model todo list

	Clear history 
	Gtree will remember which files you have loaded and maintains a history list. Press this menu item if you want to clear this history list.

	Set history size
	By default Gtree will remember the last 10 files you have opened with Gtree. If you want a longer of shorter history list press this item.

	Exit
	Close and quit Gtree 

	--- History of 

    last loaded files ----
	When pressing on a file in this list the tree is cleared and the selected file is loaded (as in “Open”). 


The “File scan wizard” will scan a folder and show how the files in the folder are related. This makes finding the right GAMS file to open easier: the file with the most children is the best candidate (hence the tree is sorted that the file with most children is on top). The wizard also gives you (as a model builder) an idea which files should be deleted because they are obsolete. Pressing the right mouse in the tree will give you a popup menu where you can rename or delete a file, or select a file that will be opened in Gtree. Behind every root filename you will see how many children are attached (between [] in blue) en how many lines (between () in cyan) the file contains.
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makeyears.gms [13] (93)
Sets.gms [8] (88)
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LoadTupel.gms [2] (3)
CreateUniversaNEGYpe.gms [1] (20)
NEG1995Typology.gms [1] (33)
NEG2006Typology.gms [1] (33)
Tables_new.gms [1] (2263)
AJGGDX GHS (12)
BDLVargms (21)
Bedrifshoofden20JaarDift gms (55)
Calculate.gms (19)
Calculations.gms (121)
‘CombineGDXgms (2807)
CreateNewTables gms (1)
Gemeente.gms (1092)
NEGTuplesyYear.gms (68)
Outputgms (17)
SaveGDX gms (2)
TuplesForTables.gms (59)
UserSelectedvariables.gms (21)
Wietse DolUserCalculations.gms (15)
Wietse DolUserSelection gms (52)
Wietse DolUserSets.gms (2)
Wietse DolUserSettings.gms (33)
_Wietse DoIGDX_gms (4)
TakeyearsDRAN.GMS (79)
‘ouden004UserCalculations. gms (15)
‘ouden004UserSelection gms (54)
ouden004UserSetings.gms (34)
tabel223V00r2006.gms (37)

Changed by: Wietse Dol (W.Dol@wur.nl)
* Remarks B

sontext
R L e R L R R

¥! Added Tortoise SVN to LIC
[¥! Please make regular backups/versions with SVN
*! <%GTREECONTROL JUMPLIST "@filenamenoext@.lst",0,0,"","Meitelling LST file"%>

[*! <3GTREECONTROL JUMPL{iST "GDXoutput_@sysenv.username@.gdx",0,0,"info.gref", "Me
N L T T

¥_= Notes for users: =

b 13k KK KKK KKK KKK KKK KKK KKK KK

This GAMS progrem works on a network and this means that different

lpeople can work/run on the same time the same code. To make this possible you

lhave to click on the link below (only the first time you start using the code).

The link will create personal files that can be used to make and save your sele
file://CreateUserTables.bat

A T LT T TT T TT T T T T TSP

If you just want to run the code select from the available tables/data and you

lare not interested in the GAMS code just have a look at the QuickNavigfation.gms

\file, make your selection/changes and run GAMS (press F9)

e A —

! <%GTREE 1 Documentation>

! <%GTREE 1.1 Which variable for which years%>

To see which Meitelling variables are available in which year click on the link
file://../../MeitellingCount.xls

The value in this spreadsheet is the number of farms in a year that have a

value for a given Meitelling variable.

If you want information on changes when having & new data year, please open and
file://AllMeitellingCount.gms

To see what needs to be changed for 2008:
file://count/Updates2009.ini
li.e. this is the output of AllMeitellingCount.gms

! <%GTREE 1.2 Changes for 2009%>

! <%GTREE 1.2.1 Tables to be checked!%>

fitelling GDX output” %>
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1.2 Actions menu item
The Actions menu item contains the menu choices:
[image: image10.png]Actions Options GAMS R Programs Temp

Find textin tree T
Find/replace text n files [z
Refresh allfiles s
Refresh current file s
‘Show GAMS is ile iz
Show GDX file B
Run project file =l
Compile project ile Shift+Fo
Run current file 0
Compile current fle Shift+F10
Delete backup files 1
Restore backup file Shift+F1L
Version Control Shift+Ctrl+ 11
Make tuples T
Import to GSE

(GSE and Gtree Tag Wizard

Insert code template 2
Code template editor shift+F2
GDX viewer i
External editor ShiftF4
StartR

Start macro key recording [N
Stop macro key recorder (Ctrl-Break)
Bxecute macro Ct+F11
Repeat macro

Macro key shortcuts




	Find text in tree (Ctrl-T)
	If you like to search for a certain filename/text string in the tree, press this menu item and you are asked to specify a search text and Gtree will search the tree and present the outcome of the search in a window. 

	Find/replace text in files (F3)
	If you need to find or replace a certain text in one or more files of the tree, press this item. See Chapter 6. Search/replace text in files.

	Refresh all files (F5)
	If you have made many changes to your files (i.e. added or changed $include statements), press this item and all the files are rescanned and a new tree is build.

	Refresh current file (F6)
	If you have added/changed $include statements or GSE tags in the currently selected file, press this item and the current file is scanned for $include and GSE tags and the tree is rebuild. Note that this option is much faster than the "Refresh all files" option and is probably the one you will use most of the time. Note that Gtree knows the file date of the file and when you have saved a newer version Gtree can automatically scan the updated file.

	Show GAMS list file (F7)
	Show a list of available GAMS LST files. When there is only one LST file, this file is shown immediately.

	Show GDX file (F8)
	Show a list of GAMS GDX files. When there is only one GDX file, this file is shown immediately.

	Run project file (F9)
	Run the files that are in the root of the tree (in our examples the AgMemod.gms file). Gtree will have a list of which programs are used for certain file extensions. When an extension/program combination isn't specified, the windows defaults are taken (see Chapter 11. Gtree INI file).

	Compile project file (Shift-F9)
	Compile the root of the tree, i.e. run GAMS and check the model but don't start the solver.

	Run current file (F10)
	Run the currently selected file.

	Compile current file (Shift-F10)
	Compile the current file.

	Delete backup files (F11)
	Select and delete backup files and other files (see Chapter 14. Cleanup files).

	Restore backup file (Shift-F11)
	Restore an old version of the current file (see 8. Restore files).

	Version control (Shift-Ctrl-F11)
	Version control system for your models (see Chapter 12. Version Control)

	Make Tuples
	Create tuples from data (see Chapter 30. Tuples)

	Import to GSE
	Run the import2gse  tool of GSE

	GSE and Gtree tag wizard
	Run the GSE tag wizard and check the correctness of the GSE tags (see Chapter 28. Gtree and GSE).

	Insert code template (F2)
	Typing text by using a few letters (see Chapter 13. Code templates).

	Code template  editor (Shift-F2)
	In this window you can add, change, and delete code templates.

	GDX viewer (F4)
	Start the Data Explorer (see manual Data Explorer).

	External Editor (Shift-F4)
	Start the external editor and open the currently selected file (see Chapter 11. Gtree INI file).

	Start R
	Start the R Graphical User Interface

	Start macro key recording (Ctrl-F10)
	You can record a series of keystrokes that will perform certain edit tasks and save these keys to file.

	Stop macro key recording (Ctrl-Break)
	Stop recording and save result to a file.

	Execute macro (Ctrl-F11)
	Select and run a key macro file.

	Repeat macro (Ctrl-F12)
	Repeat the last executed macro.


1.3 Options menu item

The Options menu item contains the menu choices:
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	Editor, GAMS, General, Reference file, Tree
	All kind of Gtree options (see below)

	File association
	Here you can set file associations to start GAMS files and GDX files with Gtree and the Data Explorer (see below).

	R
	R options used in Gtree (see below)

	Font for screens
	Select which font you want to use for the screens.

	Font for memos
	Select which font you want to use for the editors.

	Clear Clipboard history
	On the Clipboard tab you see a history of things you copied to the clipboard. This option will clear the history (see also below).

	Run parameters
	When you run GAMS or something else you sometimes need parameters to be added to the program. E.g. using GAMS we could add s=save.dat and running GAMS would imply running: 

gams.exe AgMemod.gms s=save.dat
Note that after setting run parameters the status bar will show these parameters in our example we would see in the status bar GAMS: s=save.dat

	Add sets/elements from Gref file
	When creating a reference file for the current model, the sets and elements of the selected Gref file are used (see Chapter 2).

	Environment variables
	Show window with all environment variables. Add, edit and delete environment variables.

	Edit/add Programs
	In the Gtree menu you can add additional programs you like to run/call within Gtree (see Chapter 8. Additional Programs). 

	Customize editor options
	Set the general editor options.

	Syntax editor settings
	Set the syntax coloring options of the editor.

	Tree colors
	Specify the tree colors.

	Printer options
	Set the printer options used for Gtree.

	Choose screen skin
	You will spend a lot of time working in Gtree building you GAMS models. To make live less dull we have made it possible that you can change the looks of Gtree to suit your own taste.


	Editor:
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	Auto update file header
	When you have on top of your file a header that was created by the Gtree template/macro head you can automatically change the date the file was last edited and the user who changed the file.

	Check/color matching braces
	When the cursor in the editor is above a (){}[] it will color the matching opening or closing brace.

	Autocomplete braces 
	When you type a brace ({[  a matching brace is entered. 

	Autocomplete quotes
	When you type a quote “ ‘ a matching quote is entered.

	Use deadkeys for “ ‘ ~ ’
	Some people use dead keys to easily create accented characters (so ’e will give é). Gtree needs to know this for the advanced key parsing and auto completion.

	Don't parse comment lines
	By default $include statements in comments are ignored when parsing the tree. If you want to have them also parsed use this toggle. For some model builders it is very instructive to use this option and show what could happen if you by mistake add or delete one asterisk.

	Allow jumps to *! And  *? Tags
	You can start a line with an * to create a comment in GAMS. Comments are shown in a gray color. Gtree allows 4 additional comment combinations that will be shown in different comment colors: *! *? *_ and *- This gives you possibility to make certain comments stick out or having a special meaning. With the “Allow jumps” option you can use shortcut keys (see Chapter 30. Shortcut keys) to jump between different comments in files and hence make it easy to jump to special comments (*starting with *! or *?).

	Parse file parameters
	By default the values of parameters behind a file statement (e.g. $include or in a batch file) are not parsed. You can switch this option on and parse values of parameters.

	Show parent file first
	By default when you click on a name in the tree, the file is shown in the editor. When the file has a parent file this file is shown on the first tab sheet of the editor. If you select to show the parent file first, both files are available on the tab sheets of the editor, but the parent is shown first. By clicking on the tabs you can switch between the parent and the child. Note that if you click on the parent the line of the $include statement is marked and displayed on the first line of the editor window.

	Always open external editor
	When clicking on the tree the file is loaded into the editor. This option will not use the Gtree editor but start an external editor when you click on the tree.

	Show line numbers
	All content of the editors are shown with their line numbers. You can switch this on/off.

	Tree left from memo
	By default the tree is shown on the left side of the window and the editor is shown on the right. Using this switch you put the tree on top and the editor at the bottom of the screen.

	Show horizontal scrollbar in editor
	Use a horizontal scrollbar in the editor, so you can scroll to the left and right in the editor.

	Show vertical scrollbar in editor
	Use a vertical scrollbar in the editor, so you can scroll to the left and right in the editor.



	GAMS:
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	On “Refresh all files” (F5) clear environments, globals list
	Gtree parses files and remembers GAMS code that declares globals ($set, $setglobal) and environment variables. This option will clear the lists every time you press F5. Remembering the old definitions is normally useful but in certain occasions clearing the list is better.

	Show LST file in separate window
	Check this, if you want the LST displayed in a separate window.

	Don’t show LST file after compilation (except on error)
	By default the LST file is shown after each compilation. If you check this option the LST file is only shown when there is an error in the GAMS code/run.

	Show LST tree
	A LST file can be very long and finding something can be time consuming. Hence a tree with important items can navigate you easier through the LST file (see LST tree).

	Show solve summary
	When GAMS has finished running the model, a summary of the GAMS results is shown (telling you if GAMS found an optimal solution).

	Delete WLOG when finding GAMS error
	The WLOG program is used to display messages when running your GAMS code. This option will automatically close the WLOG window when your code contains an error.

	Max. size of LIST file for LIST tree
	When Gtree shows you a LIST file it will also parse this file and create a tree. The tree makes it easy to jump to different sections of the LIST file. When LIST files become big this scanning is time consuming and hence with this option you set the maximum size of the LIST file that will parse the tree automatically. For larger files you can click with the right mouse on the editor and select from the menu “Create LIST tree”.
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	Show legend 
	By default the colors used for syntax coloring are shown under the file tree. This option makes it possible to hide the color syntax legend. See Chapter 3. Additional tabs.

	Show Clipboard history tab
	See Chapter 3. Additional tabs.

	Show Jump List tab
	See Chapter 3. Additional tabs.

	Show History tab
	See Chapter 3. Additional tabs. 

	Save changes without asking
	When you have changed the contents of a file in the editor, you are asked if you want to save the changes (e.g. when you select another file in the tree). If you use this switch the changed files are saved automatically without asking you each time if you want to save it.

	Save + load Clipboard history
	When quitting Gtree, the Clipboard history will be saved to a file and the next time you start Gtree it will be available again.

	Ignore updating GREF file
	Gtree knows when your code has changed and it will prompt you for the creation of a new reference file. When you do not want this you can switch the prompting off. When you want to create a new reference file press and hold the Ctrl key and then click on the “Reference” tab.

	Use skin for Gtree windows
	In Gtree you can select a skin to change the look and feel of the Gtree windows.

	Read GDX elements in Reference tree
	By default Gtree will also read the elements that belong to a set. Often sets with a lot of elements are stored in GDX files (instead of ASCII). This option will ignore elements coming from a GDX file and hence speed up the parsing of the tree and the creation of a reference file.

	Make backup of changed files
	Every time a file is changed and saved a backup of the file is created.

	Store backups in separate directory
	Backups are stored in a special subdirectory (and hence make it visible what files are backup files).

	Show icon in taskbar
	You can show Gtree as an icon in the taskbar. 

	On startup check for updates
	When Gtree starts, it will check the Internet 

www3.lei.wur.nl/gamstools for updates. If there are updates, they are downloaded and installed automatically.

	On startup maximize window
	Gtree shows a lot of information. Hence it is nice that Gtree starts and sees the maximal width and height of your screen.

	Number of Backup files
	You can specify the maximum number of backups Gtree saves for a single file (see Chapter 9. Restore files)
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	Show Reference tab sheet
	A switch that will show or hide the Reference tree.

	Show GAMS when creating reference file
	To create a reference file we use GAMS. This option will show the GAMS window when creating a reference file.

	Create Reference file after each compilation
	When checked, every time you run your GAMS code and it finishes without an error, Gtree will create reference file (i.e. it will perform the actions as when you click on the Reference tab sheet, see Chapter 4).

	Show filename in Reference tree
	Every reference to a file only the first time the filename is shown (and not repeated every time, but instead you will see ...). This option will show the complete filename every time.

	Description first in Reference tree
	By default you will see the GAMS name of an item and this it's description. This option will switch to description first and then the GAMS name.

	Reference file options
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A window will appear where you can select which GAMS items should be stored in a reference file.



	Tree:
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	Show line numbers of include files
	By default the line number of a file in its parent file is shown ($include). This switch will toggle and show/hide the line numbers.

	Layout line numbers
	In the tree line numbers are presented between [] With this option you can toggle the size of line numbers, e.g. [12] and [812] are of unequal size but  [_12] and [812] are of equal size. This option makes trees easier to look at.

	Show file sizes
	Sometimes it is interesting to know how large a file is. When a file is very big loading it into the editor will take some time. This option will show you in the tree the size of a file (between braces).

	Show path in tree
	Show the complete filename and pathname in the tree.

	Sort in “Files” tree on line number
	By default Gtree starts the tree with GSE and Gtree tags and then adds the include files. This option will not make this grouping but order the tree contents purely on line numbers.

	Merge includes and Gtree tags
	Takes building a tree a step further. Includes are now taken as subsections of Gtree tags (see Chapter 10. Special Gtree tags).

	Refresh file when selected in tree
	When checked and clicking on a tree file, the file is rescanned when the file date has been changed since the last scan.

	Show Gtree tags
	See Chapter 28 Gtree and GSE.

	Show Gtree control tags
	Show the special tags (see Chapter 10) in the tree.

	Show GSE/Gtree tags line numbers
	Add line numbers to the special tags.

	Hide Gtree controls $include/$batinclude
	The GTREECONTROL statements (see Chapter 10) for $include/$batinclude will not appear in the tree.

	Show GAMS commands in tree
	Show the user specified GAMS command in the tree.

	Gams dollar commands in tree
	Create a list of GAMS dollar commands that will be displayed in the tree.


When you select the menu item “Options” and click “File associations” the following window is shown:
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The menu makes it possible to start files with certain file extensions with Gtree or the Data Explorer. In the “Additional file extensions for Gtree” you can give a comma separated list of additional file extensions, e.g. .gmp,.r,.txt would also add the files with the .gmp .r and .txt file extensions to be started with Gtree. In the “Inspect file extension:” box you can type a file extension and see its currently associated program.
When you select the menu item “Options” and click “R” the following window is shown:
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Most of the window options are self explaining. The “Sleep time” and “Sleep quit time” are used in the communication of Gtree with R and when this communication isn’t working properly you can try and increase the sleep times. The “Find R” button makes it easy for you to find R somewhere on a drive (it takes time, but you only need to do it once).
1.4 GAMS menu item
The GAMS menu item contains the menu choices:
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	GAMS docs
	Here you will find a complete list of all the available GAMS documentation. Select which document you want to view. 

	GAMS library
	Opens/shows the available GAMS libraries. After selecting a library the Gtree library window is shown (see Chapter 20. GAMS library).
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	User GAMS library
	Ask for a user library and show the Gtree library window.

	Solvers
	Show a grid of available Solvers and the default settings for GAMS.

	Options
	In this window you can set some GAMS options (see Chapter 19. GAMS options)

	Find GAMS versions
	You can scan all your drives, your local drives or your network drives and create a list of all available GAMS versions. Once done you can easily switch Gtree to run different GAMS versions. See Chapter 21. GAMS versions.

	Select GAMS version
	Select from the available GAMS versions the GAMS version you want. Note that different GAMS versions generate different GDX versions.
GAMS 22.2 or below: GDX version V5

GAMS 22.3-22.5: GDX version V6

GAMS 22.6 and higher: GDX version V7

See Chapter 20. GAMS versions.

	Check for GAMS updates
	This tool will read the license file and check if you have the most up-to-date GAMS version installed.

	Copy GDX dll’s to Gtree
	Gtree and the other tools need the GDX DLL’s. This option will copy the DLL’s from the current selected GAMS version into the Gtree directory (this is useful when you start using a newer GAMS version).

	GDX info
	Start the GDX Browser program to inspect GDX files

	differences in GDX files
	Start the GDX diff program

	Convert GDX to other version
	Start the GDX conversion tool

	Merge GDX files
	Start the GDXmerge2 tool (different from GAMS GDXmerge)


In the Gtree.ini file (in the section [GamsDoc]) you can specify a list of documents that are available under a shortcut key (e.g. the Bruce McCarl manual can be started with the Alt-1 key combination).
1.5 R menu Item

This menu item shows you all documentation on R (i.e. the directory specified by the RDocs line in the Gtree.ini file). And the possibility to change the R options (see also “Options” menu item).
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1.6 Programs menu item

In the Programs menu item you can add programs you like to start from Gtree (see Chapter 7. Additional Programs).
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1.7 Templates menu item

Using menu item “Actions” and then “Code template editor” (or Shift F2) you can specify code templates and in the last two columns you can specify the Menu and Submenu. These are shown in the Templates menu item (see Chapter 13. Code templates).
1.8 Tortoise SVN menu item
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This item makes it possible to interact with Tortoise. It is wise that building a model you store versions in SVN (even if you do not work as a group on the model). Tortoise is freeware (http://tortoisesvn.net/downloads) and you can even download free server software (http://www.visualsvn.com/server/download/).
1.9 The Help menu item
The Help menu item will the menu choices:
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	Help
	Show the help file.

	About
	Show you information about this program 
(version number etc.).

	Check for updates
	Check the web for updates of Gtree.

	Send us a mail
	Send us an e-mail with your comments, remarks, and or questions.

	Version info
	Show a version info windows with changes that were made in each version.


2. Editor buttons
The editor uses buttons to give you easy edit functionality. Most of these buttons also have shortcut keys.
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	 1 New (Ctrl-N)
	Create a new file and open it in the editor.

	 2 Open (Ctrl-O)
	Open an existing file in the editor.

	 3 Save (Ctrl-S)
	Save the changes of the current file to disk.

	 4 Cut (Ctrl-X)
	Copy and delete the selected block to the clipboard.

	 5 Copy (Ctrl-C)
	Copy the selected block to the clipboard.

	 6 Paste (Ctrl-V)
	Paste the clipboard to the editor.

	 7 Undo (Ctrl-Z)
	Undo the last change in the editor.

	 8 Redo (Ctrl-U)
	Undo the previous Undo.

	 9 Find (Ctrl-F)
	Open a find window that makes it possible to find a certain string in the selected text, the current file, or the whole tree.
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	10 Replace (Ctrl-R)
	Open a find and replace window that makes it possible to find and replace strings in the selected text, the current file, or the whole tree.
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	11 Font for memo
	Select which font you want to use for the editors.

	12 Print (Ctrl-P)
	Open the Print preview window.

	13 Todo list
	Open/create a todo list.

	14 Open MS-Dos box
	Start MS-Dos box/console window.

	15 Linenumbers
	By default the editor is shown with line numbers. This button will toggle and show or hide the line numbers.

	16 Run (F9)
	Run the files that are in the root of the tree (in our examples the AgMemod.gms file). Gtree will have a list of which programs are used for certain file extensions (when an extension/program combination isn't specified, the windows defaults are taken, see Gtree INI file).

	17 Find matching character 
	When entering large complex formulas one loses count on where braces start and where the matching closing brace is. This button will mark the start and end matching characters. So it becomes possible to see where you make mistakes in your formula (either putting the closing or end character too soon or too late or forget the matching character). This matching holds for () [] '' "" // and \\ characters. Note that you can start with either the begin character or the closing character and that Gtree will find associated end or begin character. Possible shortcut keys are Ctrl-9 Ctrl-0 Ctrl-[ Ctrl-] Ctrl-' Ctrl-/ Ctrl-\

	18 Goto line (Ctrl-L)
	In an input box you can specify the line number of the current file you want to jump to.

	19 Find GAMS error number
	If you are interested (e.g. in a LST file) what a certain error number means in GAMS. Go to the beginning of the error number and click this button. As a result you will see (in the GAMS solve tab) the error message belonging to that error number. This means you do not have to scroll to the end of a file to understand what this error number means.

	20 Show GAMS list file (F7)
	Show a list of available GAMS LST files. When there is only one LST file, this file is shown immediately.

	21 Show GDX file (F8)
	Show a list of GAMS GDX files. When there is only one GDX file, this file is shown immediately.

	22 Close LST file
	When you have opened the LST file in a separate window, you can press this button to close the LST file.

	23 Find GAMS error
	If running GAMS returns an error the LST file is loaded and Gtree jumps to the first line in the LST file with an error. Pressing this button will result in opening the file that contains the error. 

	24 Go back
	When looking at the contents of a file you can find information of a set, parameter, or variable by pressing Alt-R (shows the Reference information of the word where the cursor is located). After looking at the reference information you can press this button to go back to the file where you pressed Alt-R.

	25 jump to Global bookmark
	Jumping through files makes you forget where you were working. By right clicking in the editor you can add a global bookmark, i.e. pressing this button will return to the file and position where you created the bookmark.
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On the right hand side of the buttons you will see a combo box. In this combo box you will see which syntax coloring files are available and which syntax coloring is used at this moment (see also Gtree INI file and Syntax editor settings). Below the combo box there are two buttons that are an easy way to increase or decrease the font size of the font used in the editor.
Note that in Gtree matching () {} [] at the cursor of the editor are shown in the editor by a green color, and hence you will always know the start and end, or see that one of them is missing.
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When you click with your right mouse on the tree you will get the popup menu below:
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Use this popup menu to collapse or expand the tree nodes. Most options are clear. Four of them need to be mentioned. The first one “Select as Environment file” will take the content of the selected (batch) file and use all environment declarations (like: set model=agmemod) and define the environment declarations within Gtree (see Chapter 15. Environment variables). The second one is “Save Reference tree to Excel”. This will open a window and you can select which information should be written to an Excel spreadsheet:
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The third one is "Print tree" will create a printable version of the complete tree:
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The "Print all files" option will print all files in the tree (using the printer settings as shown in the Print preview).

When you are in the editor and right-click you mouse you will see the following popup menu (most options should be clear after reading this document):
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The “Insert file hyperlink” will open a window where you can select a file and specify additional options and then insert the code in the editor. Use “Global Bookmark” to store the current file and position. So after jumping through the tree/files (e.g. you are searching some information/code) you can jump back. The current file and position can also being stored in the Jump List (see section on the Jump List below). The menu option Show element will take the word at the current cursor position and look in the reference file which description it has. The GAMS name and description is shown in the status bar (bottom of the Gtree window). The menu option Lock this file was introduced to be able to work with a group of people on a model at the same time. By locking a file only the person that locked the file is allowed to edit the file, others can only read it. After the person has finished working on the file he will again right click and then choose the menu option: Unlock this file. It is clearly visible that the file is locked:
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The file lock system also shows another nice feature of Gtree. By default GAMS comments are shown in grey. But when the first character after the star (*) is an exclamation mark (!) the line is shown in red. This makes it possible to draw attention to certain (important) comments. To extent the possibilities you could also use as a second character (after the *) a question mark (?) and the line will turn lime green, a minus (-) makes the comment line blue and an underline (_) makes the line green.
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3. Additional tabs
On the lower left side of Gtree there is a tab page with seven tabs. In this chapter we will explain the functionality of these tabs and show how you can use them to speed up your day-to-day tasks.
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The “Colors” tab page shows you which colors are used in the sysntax colouring of the content of the editor. Selecting a file, the file extension of the file will determine which syntax colouring is used (this is specified in the Gtree INI file in the [Syntax] section). For GAMS files we can create a reference file (see Chapter 4. Reference file) and this will result in the colouring of sets, parameters, variables, equations and models.
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In the “Tortoise” tab you will see the Tortosie SVN information on the currently selected file, e.g. in the example above we see that the file meitelling.gms has been modified and that we need to perform a “commit” to update the newest content with our network drive (V:\GAMS\LTC\TRUNK).
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In Gtree you can insert code templates in your editor and hence performing a lot of typing with just a simple command (see Chapter 13). In the “Template” tab you can select a code template (the code is shown below the combo box) and by pressing the [image: image41.png]


, you will insert the code in the editor.
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When you run GAMS and there is an error, Gtree will show the LST file and the error and you can easily jump to the code that generated the error (see Chapter 23). When GAMS runs without an error, Gtree will parse the LST file and show you the Solve summary in the “GAMS solve” tab sheet.
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Whenever you cut or copy something to the clipboard, the content that is placed in the clipboard is also stored in the editor under the “Clipboard” tab. The *_*_*_* line is used as a divider between the different clipboard actions. This means that you have a list of previous clipboard actions and by right clicking in the clipboard editor you can select a previous clipboard action (which is then placed in the clipboard again) and then paste the content in any other editor. The clipboard history is saved and the next time you start Gtree the history is loaded and ready to use.
[image: image44.png]e

ntd4al (Yeaﬁ Varkensset) = sum(BDLkej
ntdda2 (vea  select clipbosrd entry TC44a
*—¥_%_%_%_%  Delete clipboard entry

Clear Clipboard history
Print
2355:20484 | GAT




[image: image45.png]Colors | Tortoise | Template | GAMS solve | Cipboard | Jumplist | History |

B

&g Meiteling GDX output
B Meiteling LST fie:
Giree manual

IR bemoof R cooring
@ AmeitelingCount.gms
2 vedictcare

letse Lol, August <010





Since we are using Gtree a lot, we now tend to create large trees (which we use like a table of contents in a book). Often we add boogus $include statements in a file because we want the content of the include available in the tree. For instance we add a $include meitelling.lst command just to be able to click on the tree and show the LST file of the meitelling.gms file. This works, but only for ASCII files. The “Jump List” tab can be seen as a way to add and use hyperlinks (to internet pages, software, files and GAMS/R/Gempack code). By just double clicking on any of the lines in the list the hyperlink is executed, i.e. programs are started, internet pages are loaded and GASM/R/Gempack code is loaded in Gtree. Depending on the file extension of the jump the associated program will be started (and the correct icon displayed), e.g. a .doc document will start MS-Word and .xls will start Excel etc. Right clicking will show a popup menu (were you can run, edit, create jumps and order or delete the jumps etc.).
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When you press “Edit” or “New” the following window is opened: 
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You can start with a description that is shown in the Jump List and then specify the color that is used to show it in the list. Next you specify the file name to be started (i.e. you can also type a web address, like: http://www.medictcare.nl). The file extension will determine which icon is shown in the jump list. If the program needs additional parameters you can add them in the “Parameters” field. If you have a file that will be shown in Gtree, you can specify the column and line position where Gtree will jump to (making it possible to have more than one “Global bookmark”). The “Save to INI file” options will store the jump to the INI file when you quit Gtree and the next time you start Gtree this jump will be loaded and available again. For the “File name” and “Parameters” you can use functions, environment variables, and globals as explained for the GTREECONTROL tag (see Chapter 10).
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Having a model tree, makes it easy to jump to anywhere in your model. After a few clicks you will not remember where you came from and hence the “History” tab shows you a list of previous visited nodes of the tree. It is a historical list, meaning that the most recent record is on top of the list. Whenever you click on the Gtree tree, the node that was selected before, and the position where you were in the file at the moment of clicking, is added to the history list. Hence the history list line has three parts, first the node name, then the column/line-number where you jumped from and the third part is showing the line content you jumped from. By double clicking on an item in the list you go to that node and jump to the position in the file. When you right click on the list a popup menu will appear where you can make the jump, delete a record from the list, or clear the list completely.
4. Reference file

Building a model with a lot of $include statements will make your model much more readable and it becomes easier for you to discover where you have to change your code. GAMS can help you even more with your model. You can run GAMS with your model and create a file called a reference file. In this file you can see for all Sets, Parameters, Variables, Files, Equations and Models where they are declared, defined, assigned, controlled and referenced. Also you will find the declarations of all GAMS $set, $setglobal, $setlocal and $setenv statements. From the GAMS manual:

	Reference
	Description

	DECLARED
	This is where the identifier is declared as to type. This must be the first appearance of the identifier.

	DEFINED
	This is the line number where an initialization (a table or a data list between slashes) or symbolic definition(equation) starts for the symbol.

	ASSIGNED
	This is when values are replaced because the identifier appears on the left of assignment statement.

	IMPL-ASSIGNMENT
	This is an "implicit assignment": an equation or variable will be updated as result of being referred to implicitly in a solve statement.

	CONTROL
	This refers to the use of a set as the driving index in an assignment, equation, loop or other indexed operation (sum, prod, smin or smax)

	REFERENCE
	This is a reference: the symbol has been referenced on the right of an assignment, in a display, in an equation, or in a model or solve statement.


Of course Gtree will do all the work for you: run GAMS, read the Reference file and show the outcome in a nice tree in the References tab sheet:
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Just browse through the tree and you will get a very detailed idea how the model is defined. The node Sets you will find a list of all sets that are declared in your model. Clicking on any Set you will immediately jump to the file and line where the set is declared. If you want to know where the set is used in your mode: just start clicking on the Control item etc. etc.
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Gtree will help you even more. After giving you detailed information on Sets, Parameters, Variables, Equations and Models you will find two items in the reference tree:

Not used: here you will find a list of all things that are declared in GAMS but are not used in the model (N.B. everything displayed in the color red).

Elements: GAMS requires that Sets, Parameters, Variables, Equations and Models have unique names. This isn't true for Elements. Under this tree item you will find all kind of useful information on elements (e.g. which element names are also Set or parameter names etc.). The last two items in the tree will give you a good idea which parameters and variables use certain sets or sets combinations. When, e.g. you would add a new element to a certain set it is easy to check which parameters and variables use this set, and hence you would know which inputs would need additional data (for the new element).

Once you have created a reference tree you can use the results within your editor, i.e. for the syntax coloring and the code completion. From the menu item “Actions” select the menu item  “Create code template/syntax coloring from Model tree” and the following window will appear:
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Use this window to select which names are stored for code completion and coloring. Saving everything to lists can make the editor very slow, hence the edit box after the “Elements” check. In the edit box you specify that only sets with less elements than the  number specified in the box are used for syntax coloring and code completion. Also names of a minimal length are stored for code completion. The “Add sets to name” check box will not only do code completion, but when you select a parameter, variable, or equation it will not only give the name but also the sets that are used in this item. Typing your model is time consuming and before you know you have made a typing error. Modern programming languages all have the feature of code completion: just type a few letters press the Ctrl-J and you will get a list of all words that fulfill these letters. Select from the list what you want and the word is inserted into the code:
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Note that all set information is also added to the code when running code completion (as a result of the “Add sets to name” checkbox).  Every time you press the reference tab-sheet, the file for code completion is generated and the selected items are saved. Additional all GAMS statements (visible in a blue color in the editor) are stored in the code completion table.

When creating a reference file, Gtree will also store all names of sets, parameters etc. so they are used for syntax coloring (e.g. in the above picture it is immediately clear that MacroData is a set and MacroAssu is a parameter). This coloring will make you model much more readable and you will see immediately when you make a typing error.
Once you have created the Reference tree and when you select a Set (which will have one or more subsets) and you right click with your mouse, a popup menu will give you the option: Show elements/(sub)set grid. Clicking on this option will open a new window:
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Here you will see the tree structure of the Set and its subsets, but also find a grid with a clear indication of which elements are used in which (sub)set.

Whenever you press on the “References” tab and create a new reference file the following things will happen:

a. Run GAMS and create a GAMS reference file (named GSE.ref). This file contains all information on declarations, and usage of sets, parameters, equations, models and files. It is, however, unreadable for human eyes and is e.g. missing element information.
b. If your main file is called AgMemod.gms, Gtree will use the GSE.ref file and create an AgMemod.gref file. This file contains the parsed information from the GSE.ref file, as well as information on elements and other meta-information. This .gref file contains all information needed for good data presentation and data understanding (i.e. the Data Explorer and Data Selector use the .gref file to show you GAMS names as well as good descriptions).

c. A file called gse.template is created. In this file all the words available for code completion are stored (so you can use them as well the next time you open your model). Besides this list also all GAMS commands are available for code completion.
d. A file called GAMS.sch is created. This is a copy of the default GAMS syntax coloring file, but all parameters, sets, variables, equations, models, and elements from the previous steps are added (making sure that the syntax coloring of your model works the next time you open the model). 

Note that all files are created in the same directory as the main file of the model. Knowing which files are created and seeing their usefulness, we advise model builders to store every model in a separate folder. The technical description of a .gref reference files can be found in Chapter 31.
5. Find text in tree
When you are building large models you will probably use a lot of include files. When you look for a certain file you can use the Find text in tree (Ctrl-T) menu item. When pressing this item (or the Ctrl-T key) a window will ask you to specify a search string. In our example we look for files with the .PRN file extension.
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The result of the search is show below and when you press on a certain file (middle pane) the right pane will show the tree where this file is used. If you want to edit this file press the Goto button otherwise select another file or the Abort button.
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[334] CUSEPRN
[438] EUSEPRN
[733] CNS_MARGI8.GMS
(832] CAPSIM8_ITER.gms
(843] CAPSIM8_RES.oms
[852] Capsim8_aggreg_model.gms
[886] GSEOutputFiles.gms
[894] CAPSIM_FLAT.gms
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6. Search/replace text in files
The larger models become the more files you use and the more difficult it becomes to find some text. When you look for a certain text you can use the Find text in files (Ctrl-F) menu item. When pressing this item (or the F3 key), a window will ask you to specify a search and/or replace string. In our example we look for the DATA text string.
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Below you will find the results. In the middle pane you will find a list of the files that contain the search string. On the right you see the tree and know where the file is used. In the lower right pane you will see the selected file and the search text has been marked. When you press the Goto button the selected file is opened in the editor. The Find next button will search for the next appearance of the search string. If the search reaches the end of the selected file, the next file from the list is taken and the search is continued. The Abort button will go back to the Gtree main window. The Replace button will replace the current selected text by the replace string. If you want to change the search string in all the files press the Replace all button. Note that since the search is done using the tree structure the first file that is found e.g. when you are looking for a parameter of set will be the file where the definition is given. 
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Note that the Find and Replace buttons (see also Chapter 2) have more detailed functionality for searching and replacing text in the files. The output of the search/replace questions are the same.
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7. LST tree
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[91] Model Statistics

[107] Solution Report  SOLVE transport Using LP Froi|
[145] — EQU cost 1.000
[149] — EQU supply observe supply limit at planti
[156] — EQU demand satisfy demand at market |
[164]— VAR x shipment quantities in cases
[177]—VARz ANF 445175 +INF

[116]** SOLVER STATUS

[117]*** MODEL STATUS

[118]*** OBJECTIVE VALUE

[182] *** REPORT SUMMARY

[87Execution
[190]— 64 VARIABLE XL shipment quantities in
[198]— 64 VARIABLE XM shipment quantiies ir

[215] *** FILE SUMMARY

transportlst|

Rev 145 x86/MS Windows
"4 Transportation Problem (TRNSPORT,SEQ=1)"

lcomeTLATION TIME =
[GRMS Rev 145 x86/MS Windows
"A Transportation Problem (TRNSPORT,SEQ=1)"

Equation Listing  SOLVE transport Using LP From line 62

0.000 SECONDS 3 b WIN222-1a!

- cost define objective function
lcost.. - 1.125wx(seattle,new-york) - 0.153+x(seattle,chicago) -
- 1.125%x(san-diego, new-york) - 1.062%x (san-diego,chicago)

o (uas = 0)

- supply =I= observe supply limit at plant i
supply(seattle).. x(seattle,new-york) + x(seattle,chicago) + x(:

lsupply (san-diego) .. x(san-diego,new-york) + x(san-diego,chicago!

(z8s = 0)

]





The LST tree will help you navigate through the LST file, or makes it easier to find something in the LST file. For very long files the generation of the tree will take some time, but makes it easier to navigate. 

8. Additional Programs
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In this menu you can easily add/edit, and delete programs that can be started from within Gtree (and are visible under the Programs menu option in Gtree). Press the “New” button if you want to create a new program reference in the Gtree menu. Just enter a description and then specify the program you want to start. It is possible to add startup parameters to the program. Just remember that when you use %1 as a startup parameter, this means that Gtree will add the name of the current selected file in Gtree as a startup parameter to the program. The “Delete” button will delete the currently selected program from the menu list. Press “OK” to close this window and rebuild the Gtree menu options.

9. Restore files
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Current E-Delphi\GSEWOD! IEMOD\SOURCEIEU-modellprogSettings gms
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Changed by: Ag¥emod NL (aguenod@WUR.nl)

This global makes it possible to run the model without GSE
and save the Outcome in a special GIX file. Doing this makes it

+ possible to use the GDX dataviewer o compare scenarios.

*1Change this global to NO if you don't use GSE and want to compare scenarios yourself.
s5etGlobal UseGSE no

* File © Setvings.ams

* Buthor Agitemod NL (agmemod@WUR.n1)

* Version : 1.0

* Remark  : Here Globals are defined to navigate in a desired way through
- cthe GAMS souzce

+ Date 12/18/2005 11:17:39 M

* Changed  : 03-06-2006 11:48:58

* Switch this oprion on if you want additional information about
* your model in the List file.

*1¥hen you need additional log information turn this value to YES
s5etGlobal Debug no

* This switch will read the Excel files, create a GDX file and then stop
* i.e. not running and saving the Base Line scenario.

1001y use this option if you have updated your Excel files

*land you went to check if Aguemod reads your Excel files.

sSetGlobal Test no

*1Run the model and perform a GAMSCHK instead of solving the model
in the LST file you then can find all kind of problems with your model
*i.e. infeasibilities/non-bounds etc.

$5etGlobal GAMSCHK no

global constants for reading Excel data:
+inever change this value
ssetglobal EUData ..\..\EU-Model\data\

Decide to run the BaseLine or a Scenario
Note: you can only run a Scenario after you have run
the BaseLine once!

+1Baseline run: Running Baseline from Base data from Excel, storing them in GDX
o and saving Solution
$SetGlobal Rundption Baseline

*15cenario run: Running Scenario from Gdx BaseDataFile and loading Solution
*sSetGlobal Rundption Scenario

5ifi not setglobal Rundption sbatinclude AbortSettings.gns RunOption

Changed by: Ag¥emod NL (aguenod@WUR.nl)

This global makes it possible to run the model without GSE
and save the Outcome in a special GIX file. Doing this makes it

+ possible to use the GDX dataviewer o compare scenarios.

1Change this global to NO if you don't use GSE and want to compare scenarios yourself
s5etGlobal UseGSE no

Backup: Iv]
09-06-2006 11:48:56_4.167 Kb,

* File © Setvings.ams

* Buthor Agitemod NL (agmemod@WUR.n1)

* Version : 1.0

* Remark  : Here Globals are defined to navigate in a desired way through

- cthe GAMS souzce

+ Date 12/18/2005 11:17:39 M

* Changed  : 03-06-2006 11:48:55

* Switch this oprion on if you want additional information about
* your model in the List file. =
*1¥hen you need additional log information turn this value to YES

s5etGlobal Debug no

* This switch will read the Excel files, create a GDX file and then stop
* i.e. not running and saving the Base Line scenario.

1001y use this option if you have updated your Excel files

*land you went to check if Aguemod reads your Excel files.

sSetGlobal Test no

*1Run the model and perform a GAMSCHK instead of solving the model
in the LST file you then can find all kind of problems with your model
*i.e. infeasibilities/non-bounds etc.

$5etGlobal GAMSCHK no

Decide to run the BaseLine or a Scenario
Note: you can only run a Scenario after you have run
the BaseLine once!

+1Baseline run: Running Baseline from Base data from Excel, storing them in GDX
o and saving Solution
$SetGlobal Rundption Baseline

*15cenario run: Running Scenario from Gdx BaseDataFile and loading Solution
*sSetGlobal Rundption Scenario

5ifi not setglobal Rundption sbatinclude AbortSettings.gns RunOption

These globals manage the navigation of which countries are included in the model.
In this way you can run the whole EU-model or just one country model.

These globals manage the navigation of which countries are included in the model.
In this way you can run the whole EU-model or just one country model.

*15pecify YES if you want to run all available countires similtanously
sSetGlobal EU_TotalRun yes

*15pecify YES if you want to run all available countires similtanously
sSetGlobal EU_TotalRun yes
5ifi "SEU_TotalRunt™ == "yes" sgoto AfterSelectingCountries

+15pecizy which countries are included in the model (by using their country code)

Restore
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Every time you save a file, a backup file is created (Gtree keeps the last 99 changed files). With the “Restore backup file” action you open a window as shown above. On the left hand side the current file is shown, on the right hand side you can select which backup file you want to see. Press the Winmerge button if you want to start Winmerge and do a very detailed file comparison/restore. Press Abort to close this window and press Restore if you want to restore the current selected backup to the current file.
10. Special Gtree tags
Gtree scans for all $include, $batinclude, etc. statements and builds a tree that you can browse. There are two special comments (called Gtree tags) that influence the tree content. The first one is:

*!<%GTREE comment%>
This means that the comment is shown in the tree:
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Reserved words
Delimiters /{}4=*()i=,:><$.#[]1"6e~13%"
Comments
Strings/descriptions/elements
Integers

Floats

Sets

Parameters

vVariables

Equations/Files

Models

$Set $SetGlobal $SetLocal $SetEnv

1:41/60: 52494 GAMS.

22
23
22
25
26 |+ specify identifier of corresponding baseline

27|+ (must exist already if baseline differs from runname)
28 [ssecglobal baseline CPB baseline

29

30

[-rselect between AdmBurden and CPB baseline

[*$setglopal runname AdmBurden
ssetglobal runnane CPB baseline

51
52

33 Execute 'mkdir

"mkdiz

gax\trunnanes’;
oms\trunnanes’;

35 Execute 'mkdir xls\Srunnames';

36 'mikdir restarc\srunnames’;

37 facronyms trunnanes, Sbaselinet, tversiond;
38 nsin = endyear - beginyear + 1;

39 [If (sruznamet <> baselinet, policy = 1);
20
41 [x1<sGoree File runparms /runparms.bat/;®>
42 [File runparms /runparnms.bat/;

43 put runparms;

44 Put /'Set version=tversions';

45 Put /'Set runname=srunnames’;

46 Put /'Set baseline=sbaselines

47 [putclose runparms;

=

34 Execute

Execute





Above we see that the statement in line 41 is shown in the tree. You can also build a tree with GTREE tags by using a numbering in front of the comment: 
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7511 2.4 Information on the o] * Changed by: Ifietse Dol (W.Dol@uur.nl)

182]1.2.5 Additional informaiol * Remarks

19311.2.5 Output ontext
{12712 Quick Navigation PP —————————
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[155] 4 Calculate new Tables
1160]5 User calculation
116716 Hake Output P EP—————
(17817 Clean-up This GAMS program works on a network and this means that different
[196)8 Errors eople can work/run on the same time the same code. To make this possible you
[129] QuickNavigation.gms ave click on the Link below (only the first time you start using the code).
[124]Setlings.gms The Link will create personal files that can be used to make and save your selecftions.

i et eetone ams file://CreateUserTables.bat

R
[152] LoacData gms [ .
{27 RendTatlon o lIf you just want to run the code select from the available tables/data and you

163] dol002UserCalculations gms lare not interested in the GANS code just have a Look at the QuickNavigfation.gms

[file, make your selection/changes and run GAMS (press F9).

[£1” <%GTREE 1.1 Which ble for which years¥>
To see which Meitelling variables are available in which year click on the Link

file://../.. /MeitellingCount.xls
The value in this spreadsheet is the number of farms in a year that have a
value for a given Meitelling variable.

|If you want information on changes when having a new data year, please open and

file://AllMeitellingCount.gns

To see what needs to be changed for 2008:

file://count/Updates2008. ini
i.e. this is the output of AllMeitelLingCount.gms

— [F! <%GTREE 1.2 Changes for 2008%>
Delimiters [1 <%GTREE 1.2.1 Tables to be checked!%>

I connents *_ LTC tables to be checked!

[l strings/descriptions/elenen File://AlIMeitellingCount2008. gdx8AL1Mei tellingCount . gref&/start=CheckTheseTably
Integers
Floats

[ <XGTREE 1.2.2 Tables, Parameters, Tupels that use discontinued variables%>
[*_ LTC tables that use a discontinued variable
[file: //AllMeitellingCount2008. gdx&Al1MeitellingCount. gref&/start=StoppedTable

[*_ LTC parameters that use a discontinued variable
|file: //Al1Meitel]ingCount2008. gdx&Al1MeitellingCount. gref&/start=StoppedParanete)

Models
I ssec se [« LTC tuple that uses a discontinued variable





In version 4 of Gtree we introduced some extended functionality in the GTREE control tag. Creating Chapters, Sections, and Subsections etc. are now not only limited to integers but can be any word (as the example below shows). Note that when you are in the editor and you press Ctrl-Alt-T the current line is changed into a GTREE control tag (i.e. this makes it easy to change comments in your code to GTREE control tags).
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test.gms

wietse Dol (W.Dol@wur.nl)
1.0

01-Aug-10 09:06:11
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Wietse Dol (W.Dol@wu:

1 how to build a tree
2 how to use GTREECONTROL tag to add to a jumplist.

sofftext

<%GTREE
<%GTREE

<%GTREE 1

<%GTREE
<%GTREE
<%GTREE
<%GTREE

<%GTREE
<%GTREE
<%GTREE
<%GTREE

<%GTREE
<%GTREE
<%GTREE
<%GTREE
<%GTREE
<%GTREE

Chapter 1%>
section 1
1 section
2 section
section 1.2%>
.1 subsection 1
.2 subsection 1.2.2

People Chapter people>

People.Jim Section Jim%>

People.Karin Subsection Karin>
People.Karin.Trudy Subsubsection Trudy%>

Animals Chapter animals%>

Animals.Cat Section cats%>

Animals.Cat.Long Subsection Long%>

Animals.Cat.Long.Holy Subsubsection Holy Birman>
Animals.Cat.Short Subsection Short%>
Animals.Cat.Short.Europe Subsubsection European short hair%>





Also note that the Chapter/section name is now in the color teal and that in the “Options” menu item under the “Tree” sub menu you will find a lot of possibilities to fine tune the way the tree is presented (see the three switches at the end of this Chapter). For instance the “Layout line numbers” option, (see below the tree under the tables.gms file) where the line numbers of all the GTREE tags are resized so they have the same length.
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The second Gtree tag is the GTREECONTROL tag:

*!<%GTREECONTROL $include off%>
*!<%GTREECONTROL $include on%>
*!<%GTREECONTROL $batinclude off%>
*!<%GTREECONTROL $batinclude on%>
*!<%GTREECONTROL Skipfile%>
*!<%GTREECONTROL NoTree file_name%>
*!<%GTREECONTROL NoTree file_extension%>
*!<%GTREECONTROL GDXversion  gdxnumber%>
*!<%GTREECONTROL GAMSversion gamsnumber =%>
*!<%GTREECONTROL GAMSversion gamsnumber >=%>
*!<%GTREECONTROL NORUN%>
*!<%GTREECONTROL REBUILD%>
*!<%GTREECONTROL CLOSEWLOG%>
*!<%GTREECONTROL CLOSEWLOGERROR%>

*!<%GTREECONTROL CLOSEWLOGNOERROR%>

*!<%GTREECONTROL JUMPLIST "output.gdx",0,0,"","Test output"%>

*!<%GTREECONTROL JUMPLIST "@sysenv.username@.gdx",0,0,"","GDX output"%>

*!<%GTREECONTROL JUMPLIST "@filenamenoext@.lst",0,0,"","GAMS LST file"%>
*!<%GTREECONTROL JUMPLIST "@gdxfile@",0,0,"","GDX output"%>

*!<%GTREECONTROL OPENGDXAFTERCOMPILE "results.gdx","info.gref"%>

*!<%GTREECONTROL CLOSEGDXBEFORECOMPILE "results.gdx"%>
*!<%GTREECONTROL OPENAFTERCOMPILE "checkoutcome.bat","results.gdx"%>

*!<%GTREECONTROL OPENLSTAFTERCOMPILE%>

*!<%GTREECONTROL CREATEGREFAFTERCOMPILE%>

*!<%GTREECONTROL NOTCREATEGREFAFTERCOMPILE%>

*! <%GTREECONTROL IGNORE IGNORE,JUMPLIST,CLOSEWLOG,OPENGDXAFTERCOMPILE%>

The *!<%GTREECONTROL $include off%> tag is used to switch the Gtree scanning for includes off and *!<%GTREECONTROL $include on%> turns it on again. This means that a part of your code isn’t shown in the Files tree. This can be useful if the code is very technical and a normal model user wouldn’t be interested in it.
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$Set $SetGlobal $SetLocal $SetEnv
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GAMS.

Forldscan
. cpb. nl

Parameter calibration and base year simulation

! <SGTREECONTROL SINCLUDE offs>
soffiisting
loption
sysout
decimals
limcol =0
Limrow 0
solprint = off

Sinclude temp\ws_sets_selected

Scalars
period, tperiod,
isundefined,
errorflag
infirscyear
ctreshold
cestifundefined
initial
Ne

]





The *!<%GTREECONTROL $batinclude off%> does the same as the tag above, but for $batinclude commands.

The *!<%GTREECONTROL SkipFile%> command will stop scanning the current file for includes/batinludes. This will speedup building the Files tree, especially when the file is long and doesn’t contain includes (after a certain point). When you put this command as a first line in your file, the file is skipped.

With the *!<%GTREECONTROL NoTree showmessage.gms%> the file showmessage.gms is not shown in the Files tree. This can be useful if this file is used a lot and doesn’t really contain model code (in this example the file is used for displaying something).

With *!<%GTREECONTROL NoTree .txt%> all files with the file extension .txt are not shown in the file tree.

The *!<%GTREECONTROL REBUILD%> tag rebuilds the tree after each GAMS compilation/run (i.e. the same as pressing F5 “Refresh all files” after each GAMS run).

The *!<%GTREECONTROL CLOSEWLOG%> tag will close the wlog program (used to send messages to a progress window) after running GAMS. The *!<%GTREECONTROL CLOSEWLOGERROR%> tag will close the wlog program when there is a GAMS error (CLOSEWLOGNOERROR close when no errors).

The Jump list (see the Jumplist tab in Chapter 3. Additional tabs) is a powerful tool for having the possibility to open files, run programs documents etc. Sometimes you would like to create jump list entries that are model/file specific. This can be done with the GTREECONTROL JUMPLIST tag:

*!<%GTREECONTROL JUMPLIST "output.gdx",0,0,"","Test output"%>

After the declaration you will need to specify a comma separated list containing 5 elements:
1. File name or hyperlink (between quotes)
2. Column position of the file to jump to
3. Line position to jump to

4. Additional parameters (between quotes)
5. Description (between quotes).

In the file name, additional parameters and in the description you can use environment variables i.e. by using the @sysenv.xxx@ command (where xxx is the environment variable you want to know). For instance the windows username can be useful in your GAMS code for creating GDX output and this jump definition below will open the outpu in the Data Explorer:
*! <%GTREECONTROL JUMPLIST "@sysenv.username@.gdx",0,0,"","GDX output"%>

Also you can use some functions in the file name, description and parameters:

@file@ 

showing the filename including the path

@filename@
 
showing the filename without the path

@filenoext@ 

showing the filename with path but without file extension

@filenamenoext@ 
showing the filename without path and without file extension

@pathname@ 

show the path of the file

@fileext@ 

show the file extension

For instance we create a jump for the GAMS LST file by:

*! <%GTREECONTROL JUMPLIST "@filenamenoext@.lst",0,0,"","GAMS LST file"%>
For the file name, description and parameters you are also allowed to use values defined by $setglobal statements, e.g. *!<%GTREECONTROL JUMPLIST "@gdxfile@",0,0,"","GDX output"%> will use the value outcomes.gdx specified in the $setglobal gdxfile outcomes.gdx statement.
GAMS assumes that people never use more than one GAMS version (i.e. only the latest version). This is however not true for many modelers. In Gtree it is easy to switch between GAMS versions and with this command you can make sure that you will run your code with the correct GAMS version. For example *!<%GTREECONTROL GAMSversion 22.5 =%> will only run with the GAMS 22.5 (hence the = sign after the version number). *!<%GTREECONTROL GAMSversion 22.5 >=%> will take any version 22.5 or higher. If you open the file, Gtree will automatically switch between GAMS version when encountering this command.

The *!<%GTREECONTROL GDXversion V6C%> command will create compressed GDX files of version V6 when you run GAMS. Hence these GDX files can also be read by older GAMS version. You can select between the following GDX versions V7, V7C, V6, V6C, and V5.

The *!<%GTREECONTROL NORUN%> command will not allow to compile/run GAMS when this command is found in the main file (root file). When this command is found in children of the root file it will compile and run.

With our modeling we often have a cycle of repeated actions: we change code, run GAMS, and if there is no error we like to view one or more GDX files. Making your live easy we introduced the OPENGDXAFTERCOMPILE tag. Here you specify which GDX file you like to open after each successful compilation (i.e. no GAMS errors). You can create a comma separated list and hence adding additional parameters for the Data Explorer, e.g. which .gref file should be used. See this example: *!<%GTREECONTROL OPENGDXAFTERCOMPILE "results.gdx","info.gref"%>

When you want to start not a GDX file after compilation, use the OPENAFTERCOMPILE tag. The program associated with the file extension is used after successful compilation of the GAMS code. Note that the file and also all additional parameters are specified between quotes "". Running GAMS code that tries to create a GDX file that is open by the Data Explorer will result in a user error. To be sure that the Data Explorer has closed the GDX files you want to create we introduced the CLOSEGDXBEFORECOMPILE tag, see this example:

*!<%GTREECONTROL CLOSEGDXBEFORECOMPILE "results.gdx"%>

In the above three tags you can use environment variables and the functions as described in the JUMPLIST tag. The OPENLSTAFTERCOMPILE tag will open the GAMS LSt file after compilation.
By default all GTREECONTROL tags are shown in the tree. There are some menu options to hide certain tags, but with the IGNORE tag you can specify a comma separated list of all GTREECONTROL tags that are hidden in the tree, e.g.

*! <%GTREECONTROL IGNORE IGNORE,JUMPLIST,CLOSEWLOG%>

will hide the IGNORE, JUMPLIST and CLOSEWLOG tag from the tree.

You can type all these commands in the editor, but the fastest way is to start the Gtree Tag Editor by pressing the Ctrl / in the editor (or right click in the editor and select “GSE and Gtree tags”). Select from the Tag combo box the GTREE or GTREECONTROL tag and type in the tree title, or select an item for the GTREECONTROL tag. After selecting a GTREECONTROL command you can easily select/edit and create the tag without much effort. Also note that when you click in the file tree on a Gtree tag and then press the Ctlr / it works like an editor where you can change the contents of your selected tag.
[image: image70.png]Tag:  GTREE

Tite:
1.2.3 Tables, Parameters, Tupels relationships that use discontinued




[image: image71.png]Tag: | GTREECONTROL -

Gams/Gree command:
SBATINGIUDE i~



   [image: image72.png]Tag: | GTREECONTROL -

on off



  [image: image73.png]GTREECONTROL
Tag:




[image: image74.png]Tag: | GTREECONTROL

Gams/Gree command:
NoTree

File name or fle extension:



    [image: image75.png]Tag: | GTREECONTROL -

Gams/Gree command:
GDiversion i~
DX versions:
© V7 compressed (GAMS 22.6 and above)
V7 uncompressed
V6 compressed (GAVS 22.3-22.5)
V6 uncompressed
V5 (GAMS 22.2)



   [image: image76.png]Tag: | GTREECONTROL -

Gams/Gtree command:
GavSerson -
GAvS verson:
24
GAvS conditon:

© or higher exact




[image: image77.png]GTREECONTROL
Tag:




  [image: image78.png]Gams/Gtree command:
iebuid e i compiaten =



   [image: image79.png]Teg: |GIREECONTROL -

Goms/Gtee command:
LT -
Sump st editor:
Descrpton:
Meitlingen GOX output
Fie name yperink:
GDXoutput_@sysenv.usemame@.gdx 3

Parameters:

Xpositon: ¥ positon:

o B b [ Wewewnune




In the Options menu item under the “Tree” menu you will find several switches that influence how the Files tree looks like. Below you will find examples of three switches, first when turned off and in the second image the option is turned on. We like to have all three switches turned on.
“Options” -> “Tree” -> “Merge includes and Gtree tags”
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“Options” -> “Tree” -> “Sort in Files tree on line number”
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“Options” -> “Tree” -> “Layout line numbers”
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11. Gtree INI file
Gtree (and our other GAMS tools) has been developed with the idea that no installation of software is needed. All user settings of the software are stored in so called .INI files (plain ASCII files that can be edited by any editor, e.g. notepad). Whenever a user starts a program for the first time (say e.g. gtree.exe), the .INI file is copied to a user .INI file (i.e. the windows username is used to create a personal INI, e.g. the user DOL002 will create a DOL002_gtree.ini). All references to directories and files in the software and INI files are done by using the directory of  Gtree as a root directory (local referencing, i.e. often the symbol $local is used in the INI files to indicate this Gtree root directory). Often problems of users can be solved by deleting their user .INI files. Many options you can change when running Gtree, are saved in the GTREE.INI file. The next time you start Gtree all the previous settings are restored. There are five sections in the INI file that are used by Gtree but you cannot change within the Gtree program. You can change these sections to get a better personalized Gtree. Just to show you some of the defaults of these five sections:

[Settings]
;general settings
CopyRight=© LEI 2010
HeaderLeft={NAME}
HeaderCenter=
HeaderRight={PAGE}/{NUMPAGES}
FooterLeft={COPYRIGHT}
FooterCenter=
FooterRight={DATE}
[FileExtension]
.GMS=gams.exe

.STI=scentab.exe

.STP=scentab.exe

.BAT=

.CMD=

.GMP=gempack.bat

.TAB=gempack.bat
[Syntax]
1=GAMS.gms

2=GAMS.prn

3=Nothing.lst

4=HTML.htm

5=HTML.html

6=objectpascal.pas

7=batch.bat

8=GAMS.todo

9=GAMS.inc

10=GAMS.txt

11=GEMPACK.gmp

12=GEMPACK.tab

13=R.r
[GAMSdoc]

File1=$GAMSDIR\DOCS\BIGDOCS\GAMS2002\mccarlgamsuserguide.pdf

File2=$GAMSDIR\DOCS\BIGDOCS\gamsusersguide.pdf 
[Rdoc]

File1=$RDOCS\Reference cards\4 page card.pdf

File2=$RDOCS\Intro & courses\Rossiter-R Intro at ITC.pdf
In the first section (Settings) you will find the header and footer settings for the printer (see Print preview). The second section (FileExtension) is an extension of the windows functionality. The left hand side of an element indicates a file extension. The right hand side indicates which program is executed when you Run (F9) a file with the given file extension. So .GMS=gams.exe means that files with the .gms extension are run with the gams.exe when you press the Run button.
The third section (Syntax) is a list of used color/syntax highlighting. GAMS.gms simply means that files with the .gms extension will use the syntax coloring as defined by the GAMS scheme file (i.e. the file GAMS.SCH found in the SyntaxSchemes directory).

In the fourth section you can define documents that are shown when clicking on the GAMS menu. In the example here we define the two important GAMS manuals to be available just by pressing the Alt+1 or the Alt+2 keys.
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In the last section you can define documents that are shown when clicking on the R menu (the same as with the GAMSdoc section).

12. Version Control

Yes indeed, Gtree has very good facilities to restore a backup file (see Chapter 9. Restore files). However, when you have a model version it is important to save this version (with all its files) to make it possible to retrieve not only one file, but the whole version. Also storing a version makes it possible to investigate which differences there are between versions or the version you are currently working on (i.e. we use Winmerge for that). The Version Control window has three tabs: Archive, Restore and Compare. Please note that Tortoise SVN is a much better system to work with than the Gtree Version Control, but you have to install the SVN client software and often also have a SVN server.
The Archive tab makes it possible to store a version. You can either select to save the complete content of a directory (Archive directory) or to only save the files that are generated by your GAMS model (Archive tree). Just give your version a name and a good description. You then can add extra files or directories to the version and when finished you press the Backup button.
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In the Restore tab you select where you want to put your model version (Restore to). When you click on a model version the description and the content of the version is shown. Press the Restore button to restore the content of this version. Press Delete to delete the selected version and the Edit button makes it possible to edit the description of the model version.
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When you want to compare versions press the Compare tab. Just select the versions you want to compare (in our case we compare version 1 with the current code we have of our model) and press the Start compare button. Winmerge will be started and the differences are shown.
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13. Code templates
Building models and editing text means a lot of typing. To help you a little bit we implemented a kind of code templates, i.e. you type a word and then press the F2 key. The word (to the left of the cursor) is taken and in a list we look what text should replace the word. Simple but powerful! Have a look at the Code template window (pressing Shift-F2):
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So by typing author in the editor and then pressing F2 the word author is changed into Wietse Dol (w.dol@wur.nl). By typing $i and then pressing F2 the word i is taken and changed into include (hence you will get $include). Note from the examples above that the replacement text can be many lines long. If you want to position the cursor somewhere you can use the ^ character. So the word head at the beginning of a file will be changed into
*=============================================================================

* File      : Meitelling.gms

* Author    : Wietse Dol (W.Dol@wur.nl)

* Version   : 1.0

* Date      : 16-Aug-10 08:30:06

* Changed   :

* Changed by:

* Remarks   :

$ontext

$offtext

*=============================================================================

*============================   End Of File   ================================
and the cursor is at the place where you can enter remarks. This head example shows some more powerful features. You can insert code templates within a code template, e.g. the <%author%> in the head example is changed into Wietse Dol. Just to finish the functionality we have some predefined word:

<%file%> 

showing the filename including the path

<%filename%> 
showing the filename without the path

<%filenamenoext%> 
showing the filename with path but without file extension

<%pathname%> 
show the path of the file

<%fileext%> 

show the file extension

<%date%> 

showing the current date

<%time%> 

showing the current time

<%datetime%> 
showing the current date and time

In the code template editor you can use the grid to change the text and words. By pressing the Add button an extra row is added to the grid, so you can add a new code template. To delete a code template click in the grid which template you want to delete and then press the Remove button. The Abort button will close the code template window and doesn't save any changes made in this window. The Insert button will paste the currently selected code template result into the editor save the changes and close the window. The Save button will save the changes and close the window. As soon as you want multi line text it can be handy to edit the text not in the grid but in a separate editor. To do so press the Edit button and after you are done press the Save button to go back to the template grid.

14. Cleanup files
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I E\LENetaBasellleitelingen\Calculations\NewL TCAllisitelingCount2004 gdx

I E\LENetaBasellleitelingen\Calculations\NewL TC\AllisitelingCount2005. gdx

I E\LENetaBasellleitelingen\Calculations\NewL TCAllisitelingCount2006. gdx

I E\LENetaBasellleitelingen\Calculations\NewL TCAllisitelingCount2007 gdx

I E\LENetaBasellleitelingen\Calculations\NewL TCAllisitelingCount2008. gdx

I E\LENetaBasellleitelingen\Calculations\NewL TC\AllisitelingCount2009.gdx

I E\LENetaBasellleitelingen\Calculations\NewL TC\AIResults.gdx

I E\LENetaBasellleitelingen\Calculations\NewL TC\GDXoutput_dol002.gdx

I E\LENetaBasellleitelingen\Calculations\NewL TC\GDXoutput_ouden004 gax

I E\LENetaBasellleitelingen\Calculations\Newl TC\GDXoutput_straad11.gdx

I E\LENetaBasellleitelingen\Calculations\Newl TC\GDXoutput_Wistse Dol.gdx

I E\LENetaBasellleitelingen\Calculations\New TC\GDXoutput_wijsm004 gax

[ E\LENetsBasellleitelingen\Calculations\Newl TC\HNeg2006.ggx

I E\LENetsBaselileitelingen\Calculations\New TCIResults gax

I E\LENetaBasellleitelingen\Calculations\NewL TC\Count_MC10_gdx

[ E\LENetaBasellleitelingen\Calculations\NewL TC\Count_MC11_gdx

I E\LENetaBasellleitelingen\Calculations\NewL TC\Count_MC12_gdx

I E\LENetaBasellleitelingen\Calculations\NewL TC\Count_MC13_gdx

I E\LENetaBasellleitelingen\Calculations\NewL TC\Count_MC1_gdx

[ E\LENetaBasellleitelingen\Calculations\NewL TC\Count_MC2003_gdx

[ E\LENetaBasellleitelingen\Calculations\NewL TC\Counti_MC2004_gdx

[ E\LENetaBasellleitelingen\Calculations\NewL TC\Counti_MC2005_gdx

[ E\LENetaBasellleitelingen\Calculations\NewL TC\Counti_MC2006_gdx

[ E\LENetaBasellleitelingen\Calculations\NewL TC\Counti_MC2007_gdx

[ E\LENetaBasellleitelingen\Calculations\NewL TC\Counti_MC2008_gdx

[ E\LENetaBasellleitelingen\Calculations\NewL TC\Counti_MC2009_gdx

[ E\LENetaBasellieitelingen\Calculations\NewL TC\Count_MC2_gdx

[ E\LENetaBasellleitelingen\Calculations\NewL TC\Count_MC3_gax

I E\LENetaBasellleitelingen\Calculations\NewL TC\Counti_MC4_gax

[ E\LENetaBasellieitelingen\Calculations\NewL TC\Counti_MC5_gdx

[ E\LENetaBasellleitelingen\Calculations\NewL TC\Counti_MC5_gax

[ E\LENetaBasellleitelingen\Calculations\NewL TC\Counti_MC7_gdx

I E\LENetaBasellleitelingen\Calculations\NewL TC\Count_MCS_gax

I E\LENetaBasellleitelingen\Calculations\NewL TC\Count_MC9_gax

I EALENetaBaseleitelingen\Calculations\NewL TCWeranderingeninHeitellinglallleitellingCount2000.90x
I EALENUetaBaseleitelingen\Calculations\NewL TCWeranderingeninHeitellingallleitellingCount2001.9dx
I E\LENUetaBaseleitelingen\Calculations\NewL TCWeranderingeninHeitellinglallleitellingCount2004.gdx
I EALENUetaBaseleitelingen\Calculations\NewL TCWeranderingeninHeitellinglallleitellingCount2005.9dx
I EALENUetaBaseleitelingen\Calculations\NewL TCWeranderingeninHeitellinglallleitellingCount2006.90x
I EALENUetaBaseleitelingen\Calculations\NewL TCWeranderingeninHeitellingallleitellingCount2007.9dx
I E\LENUetaBaseleitelingen\Calculations\NewL TCWeranderingeninHeitellinglallleitellingCount2008.9dx
I E\LENetsBaselileitelingen\Calculations\New TC\AlIMsitellingCountIst

[ E\LENetsBasellleitelingen\Calculations\New TC\CalculateuseCBS Ist

[ E\LENetaBasellleitelingen\Calculations\NewL TC\CheckNewData Ist

I E\LENetaBasellleitelingen\Calculations\NewL TC\FromCBStoL E1 Ist

[ E\LENetaBasellleitelingen\Calculations\NewL TC\GANSTupels st

I E\LENetaBasellleitelingen\Calculations\New TC\makeBDLVarTables Ist

I E\LENetsBasellleitelingen\Calculations\New TC\makeVarTables Ist

I E\LENetsBasellleitelingen\Calculations\NewL TCWeitelling st





By default a list of all backup files and a list of temp directories created by GAMS (225a, 225b etc.) is shown (in the model directory and all its subdirectories). Also a list of files that is defined in the Cleanup extensions edit box is shown. To change/add/edit the Cleanup extensions, remember that the list should be comma separated and that after changing you should press the “Refresh” button to refresh the list of files that can be selected to delete. Press “Delete” to delete the selected files and press “Abort” to close this window and return to the editor.
15. Environment variables
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In the list box you see a list of all available environment variables (and their value). By clicking on any of them you can edit the value (in the value edit box) and pressing the ”Save” button will save the changes. If you want a new environment variable press the “New” button and specify the name and value and then press the “Save” button again. Pressing the “Delete” button will delete the selected environment variable.

16. Syntax editor settings
Gtree comes with roughly 35 predefined syntax colorings. In case you want more or don't like the current one you can change it using this menu item. Below you will see an example of the GAMS coloring. Just try and change the functionality. Most things are rather intuitively.
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17. Customize editor options
In case you want to change the behavior of the editor press this menu item and change the settings.
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18. Tree colors
Here you can change the colors used in building the trees. Press on the color button and select the color you want.
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19. GAMS options 
In this window you can very easily select some important GAMS options like:
· Where to read the GAMS license file

· The page width, page height

· Left and top margin

· How to display GAMS erros

· Date, time format

· Page controlling

· Character set

· Which GDX version should be used to created GDX files (works for GAMS 22.8 and higher) and if GDX files should be compressed (GAMS 22.3 and higher).

The extra field makes it possible to add by hand additional options (read the Bruce McCarl manual for detailed description of all available GAMS options).
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20. Gams library
GAMS is installed with a library containing a lot of examples. Since these are useful you can use this window to look at the descriptions of these examples and when you are interested you can press the Load button to view the currently selected example in the Gtree editor. The Close button will close the GAMS library window. Since there are many examples it can be useful to use the filter to find an example. Note that the filter works on the column that is used for sorting (in our example the Name column as is indicated by the triangle). By pressing on a column header you will sort (ascending or descending is done by clicking again on the column header) that column. Note that the filter is a SQL type filter so wildcards like *BA* are allowed.
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21. GAMS versions

You can scan all your drives, your local drives, your network drives or select a drive of folder and create a list of all available GAMS versions. Once done you can easily switch Gtree to run different GAMS versions. To scan for GAMS click on the menu item GAMS and then select the menu item Find GAMS versions.
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Just select from the combo box which drives you want to scan (i.e. you can click on the “Computer” combo box and select the drive/folder you want). The “Delete/clear current GAMS list” checkbox will either keep your current list of GAMS versions or delete this list. Press the Find button and your drives are scanned.  As a result you will get a list of all available GAMS versions:
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When you have installed and use a new GAMS version it can be wise to copy the (latest) dll’s that are used for creating GDX files to the Gtree directory. Just select the menu item GAMS and then select Copy GDX dll’s to Gtree.
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When switching between GAMS versions that generate a different version of GDX files you should copy the dll’s:

GAMS 22.2 or below: 
GDX version V5

GAMS 22.3-22.5: 
GDX version V6

GAMS 22.6 and higher:
GDX version V7.
22. Solvers
GAMS has many solvers and in this window you will see 

· which solvers are available, 

· if you have a full licensed version or a demo version of the solver

· which kind of problems can be solved with the solver

· and which solver is used by default in GAMS.

If you want to change the default solver, you can click on the grid and a available solver will become a selected solver.
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23. GAMS errors
In a perfect world we wouldn't make any mistakes. After creating our GAMS model in the editor we would press the Run button (or F9) and GAMS will solve our model and show us the lst file. We would read the list file and have a look at the results (e.g. a GDX file). Then we perhaps would change the model contents and start all over again. Great Gtree can do all that, but what if we are not that perfect and made an error in our GAMS code? Just look what happens if we make a mistake in the Transport problem:
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Note in the list file that on line 87 of the lst file the error is shown (at the bottom of the screen, since errors are often the result of previous code). In our example we see that line 79 of the file has the error $171.  On the left hand side of the lst file you see that error 171 means Domain violation for set. So of course we would immediately see that d(j,j) should become d(i,j). So we only have to go to the file at line 79 and change the code. Since your model can use many $include statements which file contains the error isn't immediately clear. To make your live easy, you can press the Find GAMS error button (the green bug button) or click on the error explanation panel (here the lower left panel with Error: 171 etc.). As a result you can edit the file on the error line and when you have corrected the error press F9 to run GAMS again to find the next error.
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24. Breakpoints in GAMS
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GAMS is famous for the clear mathematical notation, is famous for their solvers and the speed of getting a solution, but GAMS certainly isn't a modern programming language. Often people just ask: can I stop GAMS from running and inspect the outcome of a certain parameter/variable and then decide to continue or to stop running the model. With Gtree this is possible (and simple). Just hold the Ctrl key and click on the line number of the line after which you want GAMS to stop (in our example line 4 as shown with the red dot before the line number and the fact that the line is displayed in red). When running GAMS (pressing F9) it will stop and show the current status of parameters, variables, sets, and equations in the GDXviewer. After you close the GDXviewer, GAMS will ask if you want to stop the GAMS run or not. With this functionality you as a beginner as well as an advanced GAMS user could easy inspect what happens during your GAMS run (especially of interest within LOOPS).

25. GAMS dollar commands
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It can be useful to see certain GAMS commands in the tree. Just enter a list of all gams commands you want to see and press the Save button. In the screen above we have added $call and $execute to the list (as you can see in the tree there is a call statement in line 5 of the file ENVIRONMRENT.GMS).

26. R

GAMS is great for optimization and for data aggregations, but for statistics, econometrics, matrix algebra and graphs it isn’t the perfect tool. GAMS’s solution is often to write data to a GDX file and then run a separate program (to calculate a matrix inverse or to get eigenvalues etc.) and read the outcome back into GAMS. 
In the scientific world the popularity of R is growing. R is freeware and almost all new developments in statistics/econometrics are available in R (via a library). Also R is very powerful in making nice graphs that are helpful for understanding your data (e.g. model input as well as model output). 
Since one year we started to use R more intensively in our projects and learning R is a bit like learning GAMS: it takes a lot of time to understand the basics and to being able to do the things you want. R works and feels like GAMS: the more you know about it the more you love it. The marriage of GAMS and R looks a logical one: Using our data tools it is easy to have a GAMS model that saves it’s data to a GDX file, convert it into a CSV file R likes to use, start an R batch file, write the results of R in an CSV file (and save graphs to a PDF document) and to read the CSV file back into GAMS.
In version 4 of Gtree, we can show and run R code. By default it is assumed that R files have the .R file extension. Knowing that R uses the # character to specify comments (i.e. all GAMS comments should start with an * as a first character of a line, R allows to add comments anywhere in a line). Many useful Gtree tricks that work for GAMS files also work for R files, e.g. all GTREE and GTREECONTROL tags work (except that they start with an # instead of a *). We have a good syntax coloring for R files and you can communicate with the R Graphical User Interface (R GUI).
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Above you see a good example how we can use Gtree and Gtree tags to create a well structured (almost documented) R program and by pressing F9 the full code (also with the contents of the $include statements) is send to the R batch processor and the resulting log file is shown (see below). At the right hand side of the Gtree window we see that R files have 3 new buttons: [image: image108.png]


. The first button (or Ctrl-F12) wil take the current line in the editor and send it to the R Graphical User Interface (if not running Gtree will open it). The second button (or Alt-F12) will take the current selected text and send it to the R GUI (if nothing is selected the current file is send to the R GUI). The third button (Ctrl-Alt-F12) will take the current file and send it to the R GUI (when this is the main file it is almost the same as pressing F9, except that with F9 the R batch processor and not the R GUI is called).

[image: image109.png]Gtree: EALENR demos\BlockCompile.r
Eile Actions Options GAMS R Programs Templates TortoiseSVN Help

[ @ries | BLogte |
& BlockComplle.r
&-[12]1 Declarations
1311.1x
nej12y
1913z
& [22)2 Information
[23]2.1 Summary
2112218
& [3112.3 adding file to the tree using GAMS Sinclude
- [32] Demo Include.r
[12]improved list of objects
[34] shorthand
& 1351 3 Include source files to the tree
[36] Demo Include.r
[371demo.r
[38] demo.r

Colors | Tortoie | Tempate | Cipboard | umplst | story |
W rescrved words
i>5<#[1785~1%"

Bl strings/descriptions/elements

Bl ncegers
W rioats

R specials

R version 2.11.1 (2010-05-31)
opyright (C) 2010 The R Foundation for Statistical Computing
ISBN 3-900051-07-0

R is free software and comes with ABSOLUTELY NO WARRANTY.

[You are welcome to redistribute it under certain conditions.

{Type 'license()' or 'Jicence()' for distribution details.
Natural language support but running in an English locale

R is a collaborative project with many contributors.

ffype 'contributors()' for more information and

"citation()' on how to cite R or R packages in publications.

[ype 'demo()' for some demos, 'help()' for on-line help, or

'help.start()' for an HIML browser interface to help.

[Type 'q()' to quit R.

[Previously saved workspace restored]

VVVVVVVVVVVVVVVVVVVVVVVV

summary (x) ;

Min. 1st Qu. Median  Mean 3rd Ou.





If you click on a Gtree tag in the tree (e.g. 1 Declarations) and then press Alt-F12 (the second button) the code defined by this tag (uptil the next tag on the same level or uptil the end of the file, here lines 12 until 21) are send to the R GUI. This means that in Gtree you can very easily send blocks of your code to R and the tree can be used to construct these blocks.

You can also create breakpoints (i.e. press and hold the Ctrl key and then click on the line number).
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Creating breakpoints will give you the [image: image111.bmp] button. The first time you press this button, it will send to R the code starting from the first line of the file until the first breakpoint (lines 1 until 26). The second time you press the breakpoint button it will send lines 27 until line 34, and the third time it will send the remainder of the file (lines 35 until 39).
27. Print preview
When you want to print the contents of your editor this windows shows you what will be send to the printer. On the right hand side you can select the print options and when ready you can use the Print button to send the outcome to the printer.
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28. Gtree and GSE 
Since Gtree is a good alternative for the GAMSide and since Gtree can be used within GSE, the combination of GSE and Gtree will give model builders a powerful tool for making models, running scenarios and changing the model versions. Getting a GAMS model to run in the GSE interface means nothing else than adding a few comments (we called tags) into your GAMS files. This can de done by hand or using the TagEditor in Gtree The following tags are supported:
SET
ALIAS
GROUPSET
INPUT
GDXINPUT
GDXOUTPUT
GDXSYMBOL
MENUITEM
MENURESULT
MENUORDER
PROGRAM
PARAMETERLIST
IMPLICIT OUTPUT FILE
EXPLICIT OUTPUT FILE
OUTPUT
Preparing a model for GSE is very easy with the Import2GSE tool. The most time you will spend on an import, is in inserting the right GSE tags into your files. These tags can generate a lot of errors when you make typos or enter wrong tag options. Tags range from simple tags to very complex tags and after reading part III of this documentation it isn't simple to remember all the tags and their options. To simplify the insertion of tags we have developed the TagEditor. Don't think of it as a powerful editor, it is simply a tool for inserting tags in your files. Don't rush to the Gtree and the TagEditor immediately. First think for a while which parameters you want the model user to change (inputs) and which outputs you want to present to the model user. Make a list of these parameters and write down in which files they reside (or find them using the Find action). Also write down which sets, aliases, and which elements you use. After completing this list you can start using the TagEditor.

The basic idea of the TagEditor is simple: select the file you want to insert a tag, then select the text you want to put a tag around and press Ctrl / The TagEditor will now be shown and if the tag has options, all the options are shown and you can select or edit them.

After starting Gtree and selecting the transport model example we get:
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Now select the two set definitions:
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Press the Ctrl /
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From the combo box which tag we want (in our case the SET tag) and then press the Insert button:
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Now we select the a(i) parameter:
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and after pressing the Ctrl / and selecting the INPUT tag from the combo box we get:
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now we can enter the tag options: 
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and press the Insert button:
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Have you seen how easy it is! After inserting the tag, the tree is automatically updated and we can see that on line 20-24 we have a SET tag and on line 28-36 an input tag. If you want to change an already inserted tag you can do it by hand, but easier is that you place your cursor anywhere between the begin- and end-tag and press Ctrl / Again the TagEditor is started but now all the already used/inserted options are shown and you can start edit/add/change the tag-options.

Inserting tags isn't difficult (if you want to know what all the tag-options mean, just start the help file and look in the Technical manual). There is one tag that needs special attention: the GDXOUTPUT tag. If you make mistakes in the tags it will be recognized by GSE when you try to insert a model version into GSE, i.e. after parsing your model GSE will show you where you made a mistake. In the GDXOUTPUT tag you specify which parameters and variables you save as outputs and want to show to the user. GSE can't check if you wrongly identify a variable as a parameter (en visa versa), hence it could be possible that you successfully insert a model version into GSE and after running a scenario you will get an error when you save the scenario results. This is something we don't want, and hence the TagEditor can help you not making this mistake. After selecting the GDXOUTPUT tag in the TagEditor:
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Press now the GAMS button. Gtree will run GAMS and make a reference file, parse this file, and show you all the parameters and variables that are defined in your model:
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Just check which variables/parameters you want to show/put in a GDX file and click on the OK button. 
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In the PARAMETER/VARIABLE combo box we have a list of all the outputs and when selecting one of them, the options (meta-information) of this output parameter/variable is shown in the Current settings. Just change/add the options for all your outputs and after pressing the Insert button we get:
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So inserting output parameters/variables is reduced to select them from a list.

29. New model with tree template

You can select a file in which a template of a model structure you want to create is declared. Suppose that for a new micro-economic model we always want to use the same tree structure and that we create a file called MicroWave.template The content of this files looks like:

1     Sets and Elements.set
2     Declarations.gms
2.1   Stateblock Parameters.par
2.2   Exogeneous.par
2.2.1 Counters.par
2.2.2 Constants.par
2.2.3 Standards.par
2.2.4 Trends.par
2.2.5 Policy.par
2.2.6 Model Initials.par
2.3   Endogeneous.par
2.3.1 Model Parameters.par
2.3.2 Variables.par
2.3.3 Aggregation Parameters.par
2.4   Equations.equ
2.5   Models.mod
2.6   Other.par
3     Import data.inp
3.1   Loop Initialization.gms
3.2   Data Initialization.gms
3.3   Initialization schemes.gms
4     MicroWave Model.gms
4.1   Base Period Initialization.gms
4.2   Transfer from Statblock to Begin Period Model.gms
4.3   Period Model.gms
4.4   Transfer from End Period Model to Stateblock.gms
4.5   Aggregation.gms
5     Output.gms
When selecting this file a complete structure of all these files is created and shown in Gtree.

30. Tuples
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This tool is under construction. The idea is that you can take a certain parameter from a GDX file (in the example above the parameter p_192(Farmnumber,Year) ) and create a multidimensional set with a newly defined set (NGEklasse). In the example above the new set NGEklasse consists of 11 elements and the values of p_192 are mapped, i.e. all Farmnumbers for all Years that have a value between 3 and 12 will be associated to NGEklasse 1 etc. The created multidimensional set (also called tupel) LTC21b can be used to create aggregates and summations, e.g. the number of farms belonging to a certain NGEklasse are easily calculated:

NGEtotal(Year,NGEklasse)=sum(Farmnumber,1$LTC21b(Farmnumber,Year,NGEklasse));

The creation of the tupel is stored in a file and can be used when you get an update of your data to (re)create the tupel.

31. Technical description of .gref reference files

A GREF file is an ASCII file and consists of the following sections:

1. Set, Parameter, Variable, Equation Declaration

2. Element declaration

3. Sets and Elements

4. GDX inputs

5. Setglobal

6. Dimension

7. Recoding

8. Bounds

9. NonEdit

10. Info

11. Format

12. UserLevel

13. GDX file references for every parameter/variable

A section always starts with

*!START

and ends with

!!END

The ordering of the 13 sections is fixed. If a section is empty it still has a *!START *!!END statement. The first 3 sections are enough for getting the Data Explorer/Data Selector to show some meta-information. Sections 4-12 give additional information needed for special tools. For instance: sections 4 and 5 are used for the GSE Tag wizard, section 6 is used for MetaBase and the web-version of GSE will need sections 6-12. Section 13 is used for the Data Explorer and makes it possible to present data from multiple GDX files in the Data Explorer (needed for web-GSE). Since it is ASCII the GREF file can be opened by any editor and it is possible to change the contents of the file by hand.

Example of a GREF file for the GAMS transport model:

*!START Set, Parameter, Variable, Equation Declaration

0,0,1,"i","","canning plants"

1,0,1,"j","","markets"

2,1,1,"a","i","capacity of plant i in cases"

3,1,1,"b","j","demand at market j in cases"

4,1,1,"c","i,j","transport cost in thousands of dollars per case"

5,1,1,"d","i,j","distance in thousands of miles"

6,1,1,"f","","in dollars per case per thousand miles"

7,1,1,"FixedCosts","i,j","Fixed costs in thousands of dollars"

8,2,1,"x","i,j","shipment quantities in cases"

9,2,1,"z","","transportation costs in thousands of dollars"

10,3,1,"cost","","objective function"

11,3,1,"demand","j","demand at market j"

12,3,1,"supply","i","observe supply limit at plant i"

*!!END

*!START Element declaration

0,"seattle",""

1,"san-diego",""

2,"brussels",""

3,"new-york",""

4,"chicago",""

5,"topeka",""

*!!END

*!START Sets and Elements

0,0

0,1

0,2

1,3

1,4

1,5

*!!END

*!START GDX inputs

*!!END

*!START Setglobal

*!!END

*!START Dimension

*!!END

*!START Recoding

*!!END

*!START Bounds

*!!END

*!START NonEdit

*!!END

*!START Info

*!!END

*!START Format

*!!END

*!START UserLevel

*!!END

*!START GDX datafiles

*!!END
32. Shortcut keys for GTREE

	Key
	Explanation

	Alt-R
	Search the reference tree for the selected word or the word at the current cursor.

	Ctrl-Alt-R
	Go back to line/file from last Alt-R

	Alt-I
	Include file (add $include command in current editor)

	F1
	Help

	F2
	Insert code template

	Shift-F2
	Code template editor

	F3
	Find and Replace

	F4
	start external GDX viewer

	Shift-F4
	start external editor

	F5
	Refresh all files

	F6
	Refresh current file

	F7
	Show GAMS LST file

	F8
	Show GDX file

	F9
	Run project file

	Shift-F9
	Compile project file

	Alt-F9
	jump to GAMS error

	F10
	Run current file

	Shift-F10
	Compile current file

	F11
	Delete backup files

	Shift-F11
	Restore backup file

	F12
	Create code template/syntax coloring from Model Tree

	Ctrl-B
	Start last GDX file

	Ctrl-E
	Exit

	Ctrl-/
	Start GSE tag editor

	Ctrl-S
	Save files

	Ctrl-Z
	Undo

	Ctrl-U
	Redo

	Ctrl-G
	Goto line

	Ctrl-F
	Find text in documents

	Ctrl-T
	Find text in tree

	Ctrl-R
	Replace

	Ctrl-L
	Next for Find/Replace

	Ctrl-Y
	Delete line

	Ctrl-( Ctrl-[ Ctrl-{ Crl-“ Ctrl-‘
	Find matching character

	Ctrl-N
	New file

	Ctrl-O
	Open file

	Ctrl-P
	Print

	Ctrl-M
	Hide/show tree panel

	Ctrl-Alt-M
	Show MetaBase information

	Ctrl-X
	Cut

	Ctrl-C
	Copy

	Ctrl-V
	Paste

	Ctrl-Alt-S
	Select skin for windows

	Ctrl-K 1
	Define bookmark 1. There are 9 bookmarks (1 .. 9).

	Ctrl-1
	Goto bookmark 1. 

	Alt + Left mouse
	Select block (i.e. columns)

	Ctrl-Shift-L
	Copy current line

	Ctrl-U
	Put selected block in uppercase

	Ctrl-L
	Put selected block in lowercase

	Alt-T
	Switch words

	Ctrl-D
	Open MS-dos box

	Ctrl-J
	Code completion for sets, parameters, variables etc.

	Alt-0, Alt-1, Alt-2 etc.
	Collapse/expand a tree a level 0, 1, 2 etc.

	Ctrl-↑ Ctrl-↓ Alt-↑ Alt-↓
	Previous, Next *! Comment; Previous, Next *? Comment

	Ctrl “line number”
	Mark line as breakpoint

	Ctrl-I
	Find the word “infes” in the current file

	Ctrl-F10
	Start macro key recording

	Ctrl-Break
	Stop macro key recording

	Ctrl-F11
	Execute macro

	Ctrl-F12
	Repeat  macro

	Alt-C Ctrl-Alt-C
	Add to lines of selected block a comment character (ctrl-alt-c is remove comment)
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